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С
овершенствование архитектуры СБИС

программируемой логики и развитие

технологии их производства позволя-

ют использовать эти микросхемы для реали-

зации все более сложных проектов. В соответ-

ствии с принятым для СБИС ПЛ маршрутом

проектирования завершающим этапом про-

цесса разработки является верификация1 про-

екта на физической модели, или системная

отладка, то есть отладка на плате в окружении

реальных устройств, с которыми взаимодей-

ствует СБИС ПЛ. Такая отладка позволяет

проверить работоспособность устройства при

подаче на него реальных сигналов и в усло-

виях помех, устранить нестыковки в интер-

фейсной части и ошибки разводки печатной

платы. Часто исследования на физической мо-

дели в реальном времени являются единст-

венным средством верификации системы

(особенно для сложных проектов), посколь-

ку имеется ряд причин, ограничивающих воз-

можности программного моделирования (си-

муляции). Во-первых, достоверность про-

граммного моделирования ограничивается

соответствием модели входного воздействия

реальным условиям. Во-вторых, процесс про-

граммной симуляции может занимать недо-

пустимо большое время, так как в модельном

времени исследование ведется на несколько

порядков медленнее.

Для отладки электронных устройств ис-

пользуются различные приборы: осцилло-

графы, логические анализаторы, генераторы

специальных сигналов и др.

Логический анализатор — устройство,

предназначенное для записи и анализа циф-

ровых последовательностей. Структура ло-

гического анализатора приведена на рис. 1.

Необходимыми компонентами логическо-

го анализатора являются: 
•• память для записи отсчетов; 
•• средства управления записью в память (ци-

фровая логика); 
•• средства подключения к наблюдаемым сиг-

налам; 
•• средства отображения и анализа. 

Для записи заданного количества отсче-

тов последовательности входных цифровых

сигналов подается команда начала записи

(Trigger). Отсчеты с заданной тактовой час-

тотой записываются в память логического

анализатора, а затем выводятся для отобра-

жения и анализа.

Ведущие производители измерительного

оборудования выпускают логические анали-

заторы с десятками входов, тактовыми часто-

тами до нескольких сотен мегагерц, имеющие

развитые средства отображения и анализа.

Существенным ограничением в использова-

нии таких средств является их высокая стои-

мость (десятки тысяч долларов), сложность

подключения к исследуемой системе (особен-

но к элементам на печатной плате), внесение

измерительной погрешности, невозможность

контроля внутренних сигналов СБИС ПЛ.

В качестве логических анализаторов могут

быть использованы и современные цифровые

осциллографы, с той лишь разницей, что они

имеют типичное число каналов наблюдения

от двух до четырех, а стоимость их находится

в пределах нескольких тысяч долларов.

Кроме высокой стоимости у внешних

средств наблюдения процессов в цифровых

электронных устройствах существует еще

один недостаток, связанный со сложностью

подключения к интересующим сигналам на

плате. Во-первых, подключение приводит

к погрешности измерений. А во-вторых, ча-

сто к интересующим сигналам на плате про-

сто нет физического доступа из-за того, что

микросхема программируемой логики вы-

полнена в корпусе BGA, а сигналы разведе-

ны во внутренних слоях печатной платы.

САПР Quartus II предоставляет комплекс

средств для системной отладки проектов, поз-

воляющих как заменить внешние приборы

измерения и анализа, так и облегчить под-

ключение этих внешних приборов. К средст-

вам системной отладки САПР Quartus II

(рис. 2) относятся:
•• редактор отладочных выводов (SignalProbe

Pins);
•• редактор интерфейса для внешнего логи-

ческого анализатора (Logic Analyzer Interface

Editor);
•• редактор содержимого памяти в систем-

ном окружении (In-System Memory Content

Editor);
•• встраиваемый логический анализатор

Signal Tap II (Signal Tap II Logic Analyzer).

При использовании средств системной от-

ладки САПР Quartus II рекомендуется вы-

полнять инкрементальную компиляцию2.

При этом добавление средств отладки не бу-

дет вносить изменений в размещение и раз-

водку отлаживаемого проекта и, таким об-

разом, его характеристики останутся неиз-

менными. Кроме того, в случае изменения

настроек средств отладки время повторной

компиляции будет значительно сокращено.

Пакет Quartus II предоставляет средства для

подключения сигналов проекта, доступных

в Node Finder после синтеза, к выводам СБИС

ПЛ, которые свободны от основных функ-

ций проекта и назначены пользователем для

контроля функционирования устройства

в системе. К таким средствам относятся от-

ладочные выводы (SignalProbe Pins) и интер-

Данный обзор посвящен средствам отладки САПР Quartus II, позволяю�

щим осуществлять системную отладку проектов на основе СБИС ПЛ про�

изводства компании Altera (предполагается, что читатель знаком с базо�

выми функциями пакета Quartus II).

Средства 

системной отладки САПР

Quartus II

1 Верификация (от лат. verus — истинный, facere — делать) — проверка каких-либо теоретических положений путем их сопоставления

с опытными (эмпирическими) данными.
2 Инкрементальная компиляция позволяет перекомпилировать только те блоки проекта, в которые были внесены изменения

со времени предыдущей компиляции.

Рис. 1. Структура логического анализатора
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фейс для подключения внешнего логическо-

го анализатора (LAI). Выполняя близкие

функции по выводу внутренних сигналов

проекта на выделенные для отладки контак-

ты СБИС ПЛ, эти средства имеют различные

возможности настройки, используют различ-

ные редакторы настройки и различный ре-

сурс СБИС ПЛ.

Отладочные выводы 
(SignalProbe Pins)

Самым простым средством системной

отладки являются отладочные выводы

(SignalProbe Pins). Используя SignalProbe, раз-

работчик может сделать доступными для на-

блюдения внутренние сигналы проекта, на-

значив их на незанятые в проекте выводы

СБИС ПЛ. Последовательность этапов рабо-

ты с SignalProbe приведена на рис. 3.

Вид окна редактора отладочных выводов

(SignalProbe Pins) показан на рис. 4.

Редактор позволяет выбрать в окне Current

and potential SignalProbe pins размещение от-

ладочных выводов (выполняется сортиров-

ка по любым колонкам), дать имя выбранно-

му тестовому выводу, указать с помощью

Node Finder источник сигнала для него, на-

значить выход как регистровый или комби-

наторный и задать для него стандарт вво-

да/вывода.

Для добавления требуемых отладочных вы-

водов к проекту нужно разрешить их исполь-

зование (SignalProbe Enable) перед компиля-

цией и запустить SignalProbe Compilation.

В случае успешной компиляции в колонке

Status подключенные отладочные выводы

имеют состояние Routed.

При использовании отладочных выводов,

создаваемых с помощью SignalProbe, не тра-

тится логический ресурс СБИС ПЛ. Для вы-

вода внутренних сигналов задействуется толь-

ко неиспользованный в основном проекте ре-

сурс разводки микросхемы. Это гарантирует

сохранение характеристик пользовательско-

го проекта.

Интерфейс для внешнего
логического анализатора 
(Logic Analyzer Interface, LAI)

Упрощенная структура LAI приведена

на рис. 5.

Каждый тестовый модуль LAI представля-

ет собой параметризируемый по разряднос-

ти и числу входов мультиплексор, на вход ко-

торого с помощью Node Finder выбираются

сигналы анализируемого проекта. Выходы

мультиплексора LAI назначаются на незаня-

тые в проекте выводы СБИС ПЛ. Тестируе-

мое устройство через JTAG-интерфейс под-

ключается к компьютеру (с помощью загру-

зочного/отладочного кабеля). Интерфейс

редактора LAI предоставляет пользователю

возможность управления мультиплексором

для выбора нужных сигналов. Последователь-

ность этапов работы с LAI приведена на рис. 6.

Файл LAI создается посредством редакто-

ра пакета Quartus II после завершения ком-

Рис. 2. Средства системной отладки САПР Quartus II

Рис. 3. Последовательность этапов работы

с SignalProbe Рис. 4. Окно редактора отладочных выводов

Рис. 5. Упрощенная структура LAI

Рис. 6. Последовательность этапов работы с LAI
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пиляции проекта (его синтеза, размещения

и разводки в кристалле СБИС ПЛ). Прежде

чем использовать LAI, рекомендуется прове-

сти отладку проекта на программной моде-

ли средствами пакета Quartus II.

После создания или изменения интерфей-

са для внешнего логического анализатора по-

вторяется полная компиляция проекта, при ко-

торой средства коммутации, необходимые для

LAI, размещаются на свободных функцио-

нальных преобразователях СБИС ПЛ. Отком-

пилированный проект с LAI загружается

в СБИС ПЛ, в редакторе LAI для каждого те-

стового модуля выбираются коммутируемые

на выход мультиплексора банки сигналов.

Смена банков осуществляется оперативно

в редакторе LAI и не требует перекомпиля-

ции и перезагрузки. Поскольку для исполь-

зования LAI не требуются внутренние блоки

ОЗУ СБИС ПЛ, этот интерфейс может раз-

мещаться как в микросхемах семейств Arria,

Cyclone и Stratix, так и в микросхемах семей-

ства MAX II. 

Для открытия нового файла LAI возмож-

ны два пути:
•• выбрать пункт меню Tools => Logic

Analyzer Interface Editor (рис. 2);
•• выбрать пункт меню File => New => Other

Files => Logic Analyzer Interface File.

В результате откроется окно для настрой-

ки нового файла LAI с именем по умолчанию

lai1.lai (рис. 7).

Область менеджера тестов (Instance Manager)

позволяет в рамках одного файла LAI создать

несколько тестовых модулей (но не более 16)

для вывода на контакты СБИС ПЛ  внутрен-

них сигналов проекта. Выходные контакты

назначаются для каждого тестового модуля

индивидуально. Для создания нового теста

следует щелкнуть правой кнопкой в поле ок-

на менеджера тестов и выбрать Create Instance.

Создаваемым тестам по умолчанию присва-

ивается имя auto_lai_x (разработчик может

переименовать его по своему усмотрению).

Менеджер тестов позволяет выбрать нужный

тестовый модуль для настроек и подключе-

ния, показывает статус каждого теста и зани-

маемый аппаратный ресурс.

В области настройки JTAG (JTAG Chain

Configuration), не обращаясь к окну програм-

матора, можно:
•• задавать средства программирования

(в примере на рис. 7 выбор средства про-

граммирования еще не сделан);
•• определять состояние JTAG-цепи и выби-

рать нужное для тестирования устройство;
•• выбирать программирующий файл и за-

пускать процесс программирования мик-

росхемы СБИС ПЛ.

Область логического представления тес-

тового модуля LAI в виде мультиплексора

отображает его настройки. Эти настройки

производятся в область редактирования па-

раметров. Здесь для каждого тестового мо-

дуля можно задать параметры ядра (Core

Parameters), выводов микросхемы (Pins)

и групп внутренних сигналов проекта (Banks).

Щелчок левой кнопкой в меню выбора на-

строек области редактирования параметров

или по соответствующему имени в облас-

ти логического представления вызывает

всплывающее окно настройки выбранного

параметра.

Настройка Core Parameters задает:
•• количество входов мультиплексора Bank

count (присваиваемое по умолчанию имя

банка Bank_x может быть изменено разра-

ботчиком по своему усмотрению);
•• разрядность выходной шины мультиплек-

сора Pin count;
•• комбинаторный или регистровый вывод

наблюдаемых сигналов;
•• состояние выходов при включении пита-

ния.

Настройка выводов (Pins) показывает при-

своенные по умолчанию имена выводов те-

стового модуля LAI и размещение этих вы-

водов на кристалле (рис. 8). Двойной щелчок

левой кнопкой в столбце Location открывает

окно Pin Planner для задания или корректи-

ровки размещения выводов и, при необхо-

димости, стандарта ввода/вывода. 

Настройка входов мультиплексора (Banks)

выполняется для выбранной группы внут-

ренних сигналов проекта, или для всех групп,

и подключает к входным шинам мультиплек-

сора внутренние сигналы, которые будут до-

ступны для наблюдения (рис. 9).

Для каждой группы (банка) заполняется

таблица Node, в которой для каждой линии

группы с помощью Node Finder (двойной

щелчок левой кнопкой в поле Name) выби-

рается подключаемый внутренний сигнал.

В столбце Alias именам выбранных сигналов

для удобства восприятия могут быть заданы

синонимы. 

На рис. 10 приведен пример проекта с исполь-

зованием LAI. В LAI подключены два создан-

ных тестовых модуля: LA_ROM и LA_Coun.

Для редактирования параметров выбран тес-

товый модуль LA_Coun. В нем для передачи

на выход выбран Bank_0. Назначение банка

для передачи на выход мультиплексора воз-

можно только при выполнении двух условий:
•• микросхема программируемой логики

должна быть сконфигурирована проектом,

содержащим LAI;
•• отлаживаемое устройство должно быть

подключено к управляющему компьюте-

ру (по JTAG-интерфейсу) с помощью за-

грузочного/отладочного кабеля.

Для подключения другого банка или от-

ключения выводов нужно щелкнуть пра-

Рис. 7. Окно файла LAI

Рис. 8. Настройка выводов LAI Рис. 9. Настройка входов мультиплексора LAI
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вой кнопкой в поле Core Parameters или по

наименованию банка. Во всплывающем ок-

не (рис. 10) выполняется требуемая уста-

новка. 

Прежде чем начать работу с Logic Analyzer

Interface, нужно убедиться, что к проекту под-

ключен требуемый файл LAI и что исполь-

зование интерфейса логического анализато-

ра разрешено. Разрешить использование LAI

можно, выбрав пункт меню Assignments =>

Settings => Logic Analyzer Interface. После за-

вершения процесса отладки интерфейс для

подключения логического анализатора мо-

жет быть исключен из проекта аналогичным

образом.

Аппаратные блоки Logic Analyzer Interface

автоматически включаются в состав проекта

и отображаются в окне иерархии (рис. 11).

Редактор содержимого памяти
в системном окружении 
(In�System Memory Content Editor)

Анализ данных, записанных в блоки памя-

ти СБИС ПЛ, позволяет упростить отладку си-

стем, в которых содержимое блоков памяти

модифицируется в процессе работы (напри-

мер, проконтролировать содержимое приня-

того или подготовленного к передаче пакета

в системах телекоммуникаций или проанали-

зировать данные, сохраненные в стеке синте-

зируемого процессорного ядра). Особенно

важна возможность анализа содержимого бло-

ков памяти на физической модели, посколь-

ку симулятор пакета Quartus II не позволяет

решить эту задачу на имитационной модели.

Доступ к записанным в память данным

в процессе работы осуществляется через созда-

ваемый редактором содержимого памяти в си-

стемном окружении (In-System Memory Content

Editor) дополнительный порт. Поэтому воз-

можность анализа доступна только для мо-

дулей однопортовой памяти — RAM: 1 PORT,

ROM: 1 PORT, и для параметризируемых мо-

дулей констант LPM_CONSTANT. Для анали-

за в системе содержимого создаваемого блока

памяти необходимо указать эту возможность

при настройке в редакторе параметризируе-

мых модулей MegaWizard (рис. 12).

Доступ к записанным в настроенную для

отладки память данным выполняется с по-

мощью редактора содержимого памяти в си-

стемном окружении (рис. 13).

Область настройки JTAG такая же, как и для

интерфейса LAI, она позволяет определить

положение целевой СБИС ПЛ в JTAG-цепоч-

ке, выбрать программирующий файл и вы-

полнить конфигурирование. Для сконфигу-

рированной микросхемы становится актив-

ной область менеджера тестирования памяти.

Менеджер тестирования отображает до-

ступные для тестирования блоки памяти

и константы с именами, данными им при на-

стройке (рис. 12), их статус и характеристи-

ки, позволяет выполнять циклическое или

однократное чтение, остановку циклическо-

го чтения и запись. Считанные из тестируе-

мых блоков памяти значения отображаются

в области данных.

Кроме отображения считанных значений

область данных позволяет редактировать

данные. Для редактирования стандартным

образом выделяется и модифицируется код

по выбранным адресам. Щелчок правой

кнопкой в поле области данных вызывает

всплывающее окно редактора, которое об-

легчает редактирование, позволяет записать

модифицированные слова в память, изме-

нять константы (например, при отладке

фильтров), экспортировать считанные дан-

ные в файл для дальнейшего анализа и им-

портировать данные из файла для записи

в память. В нижнем правом углу окна отоб-

ражается положение курсора.

Значения в области данных отображаются:
•• черным цветом, если считанные данные

совпадают предыдущими отображаемыми

данными;

Рис. 10. Пример проекта с использованием LAI

Рис. 11. Окно иерархии проекта с подключенными средствами отладки

Рис. 12. Настройка параметров блока памяти для работы с In�System Memory Content Editor
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•• красным цветом, если считанные данные не

совпадают или в СБИС ПЛ записаны новые

данные из In-System Memory Content Editor;

•• синим цветом — модифицированные,

но еще не записанные в блоки памяти

СБИС ПЛ данные.

Использование редактора содержимого па-

мяти в системном окружении повышает опе-

ративность отладки и увеличивает ее возмож-

ности, так как при этом не требуется пере-

конфигурирования СБИС ПЛ для изменения

содержимого блоков встроенного ОЗУ.

Встраиваемый логический 
анализатор SignalTap II

Наиболее интересным и богатым по воз-

можностям средством системной отладки

САПР Quartus II является встраиваемый ло-

гический анализатор SignalTap II.

Выше уже были перечислены необходи-

мые компоненты логического анализатора.

Все эти компоненты входят с состав системы,

включающей отладочную плату со СБИС ПЛ:
•• память для записи отсчетов в реальном

масштабе времени реализуется на блоках

встроенного ОЗУ;
•• в качестве средств отображения и анализа

может использоваться подключенный

к СБИС ПЛ через загрузочный/отладоч-

ный кабель компьютер с соответствующим

программным обеспечением;
•• управление записью в память может реа-

лизоваться на логическом ядре СБИС ПЛ;
•• подключение к внутренним сигналам и вы-

водам микросхемы СБИС ПЛ осуществля-

ется стандартными средствами САПР

и вносит минимальные искажения в на-

блюдаемые сигналы.

Функциональная схема SignalTap II приве-

дена на рис. 14.

Встраиваемый в проект логический анали-

затор SignalTap II представляет собой пара-

метризируемую мегафункцию, имеющую

специализированный пользовательский ин-

терфейс. Доступ к мегафункции SignalTap II

возможен как с помощью редактора параме-

тризируемых модулей MegaWizard (рис. 15),

так и через специализированный пользова-

тельский интерфейс — открытием stp-фай-

ла в окне Tools, как показано на рис. 2.

SignalTap II позволяет:
•• осуществлять запись логических состоя-

ний сигналов проекта, используя выбран-

ный внутренний или внешний сигнал для

тактирования;
•• выбирать сигналы проекта для наблюде-

ния;
•• подключаться к САПР Quartus II через

JTAG-интерфейс СБИС ПЛ;
•• захватывать наблюдаемые сигналы в реаль-

ном времени на частотах свыше 300 МГц. 

SignalTap II входит как программный мо-

дуль в состав Quartus II, в том числе и в его

свободную версию Web Edition. Отметим

особо, что для использования SignalTap II

в Quartus II Web Edition необходимо разре-

шить опцию TalkBack: Tools => Options =>

Internet Connectivity => TalkBack Options =>

Turn on the Quartus II software TalkBack feature.

Основные шаги работы с SignalTap II:
•• установка и настройка;

Рис. 13. Окно редактора содержимого памяти в системном окружении

Рис. 14. Функциональная схема SignalTap II

Рис. 15. Вызов мегафункции SignalTap II через MegaWizard
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•• определение момента начала захвата дан-

ных (Data Triggering);
•• захват данных (Data Capture);
•• анализ записанных данных (Data Analysis).

Для проведения отладки проекта могут

быть использованы несколько встроенных

логических анализаторов (файлов с расши-

рением .stp). Для открытия нового файла STP

существуют два способа:
•• в меню Tools выбрать пункт SignalTap II

Logic Analyzer;
•• создать новый файл через меню File =>

New => Other Files => SignalTap II File.

В обоих вариантах откроется файл с именем

по умолчанию STP1.stp (как обычно, разработ-

чик может переименовать его по своему усмо-

трению). Можно создать несколько разных stp-

файлов, но к проекту единовременно может

быть подключен только один из них (пункт

меню Assignments => Settings => SignalTap II

Logic Analyzer => SignalTap II File name).

Пример файла STP, создаваемого через спе-

циализированный пользовательский интер-

фейс, приведен на рис. 16.

Окно файла STP содержит несколько обла-

стей, обеспечивающих настройку тестов, их

запуск, отображение и хранение результатов:
•• область менеджера тестов (Instance Manager);
•• область редактирования параметров (Signal

Configuration);
•• область выбора наблюдаемых сигналов

и просмотра временных диаграмм (Waveform

Viewer);
•• область настройки JTAG (JTAG Chain

Configuration);
•• область иерархии;
•• область сохранения данных.

Область менеджера тестов (Instance Manager)

позволяет в рамках одного файла STP создать

несколько тестов (но не более 16) для провер-

ки функционирования различных блоков от-

лаживаемого устройства.

Для создания нового теста следует щелк-

нуть правой кнопкой в поле области менед-

жера тестов (рис. 17) и выбрать Create Instance.

Создаваемым тестам по умолчанию при-

сваивается имя auto_signaltap_x, которое

в дальнейшем может быть заменено разра-

ботчиком на содержательное имя. Менеджер

тестов позволяет выбрать нужный тест для

установок, запуска, отображения, показыва-

ет статус каждого теста и занимаемый аппа-

ратный ресурс, указывает на готовность

SignalTap II к запуску или необходимость пе-

рекомпиляции проекта при изменениях на-

строек тестов.

Область редактирования параметров (Signal

Configuration) показана на рис. 18.

В этой области можно задать следующие

параметры:
•• тактовый сигнал для записи отсчетов в па-

мять логического анализатора (Sample

Clock);
•• количество отсчетов в записываемой вы-

борке (Sample Depth);
•• режим формирования захвата (Trigger flow

control);
•• позицию захвата (Trigger);
•• число условий для формирования сигнала

захвата (Trigger Level).

Выбор сигнала тактирования осуществ-

ляется через Node Finder. При выборе так-

тового сигнала предпочтение должно быть

отдано глобальному сигналу. Также может

быть выбран внешний сигнал тактирова-

ния, с автоматическим созданием внешне-

го вывода. Запись данных в память логиче-

ского анализатора осуществляется по каж-

дому положительному перепаду тактового

сигнала.

Память для записи отсчетов SignalTap II

в зависимости от настроек может быть пред-

ставлена или в виде кольцевого буфера,

Рис. 16. Окно файла STP

Рис. 17. Создание нового теста STP

Рис. 18. Область редактирования параметров STP
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или в виде сегментированного буфера

(рис. 19). В эти буферы непрерывно, с час-

тотой Sample Clock, ведется запись данных.

Размер буферов определяется параметром

Sample Depth.

SignalTap II имеет два режима формирова-

ния сигнала захвата:
•• последовательностный режим (Sequental) —

позволяет использовать и комбинировать

стандартные условия захвата;
•• режим формирования условий на основе

машины состояний (State-based) — позво-

ляет создавать сложные пользовательские

условия захвата.

Выбор положения позиции захвата опре-

деляет соотношение выводимых отсчетов до

позиции Trigger и после нее и осуществляет-

ся посредством использования следующих

установок:
•• Pre — отображаются данные, записанные

до момента захвата;
•• Center — отображаются данные, записан-

ные как до, так и после момента захвата;
•• Post — отображаются данные, записанные

после момента захвата. 

При использовании сегментированного бу-

фера заданное положение позиции захвата

будет одинаковым для всех сегментов.

В качестве сигнала захвата может исполь-

зоваться и внешний сигнал (порт Trigger-In),

для которого задаются условия формирова-

ния сигнала захвата. 

Для наблюдения внешними инструмен-

тальными средствами момента захвата мо-

жет применяться неиспользуемый в проек-

те вывод микросхемы (порт Trigger-Out),

для которого задается активный уровень сиг-

нала.

Область выбора наблюдаемых сигналов

и просмотра временных диаграмм (Waveform

Viewer) предоставляет возможности для вы-

бора записываемых в кольцевой буфер сиг-

налов (рис. 20) и формирования условий за-

хвата для заданного количества условий

Trigger Level. Также в этой области отобра-

жаются записанные в память SignalTap II зна-

чения наблюдаемых сигналов (рис. 21) для

каждого из создаваемых тестов. 

Для выбора сигналов нужно перейти на за-

кладку Setup и двойным щелчком правой кла-

виши в поле колонки Node/Name вызвать

Node Finder. В нем нужно установить маску,

позволяющую отображать только те сигна-

лы, наблюдение которых возможно с помо-

щью SignalTap II. Не все внутренние сигналы

проекта могут наблюдаться средствами

SignalTap II. Сигналы, наблюдение которых

невозможно:
•• LE Carry Chain Outputs;
•• PLL Clock Output;
•• LVDS_RX/LVDS_TX;

•• CDR_RX/CDR_TX;
•• сигналы JTAG-интерфейса.

Установленные в окне Setup сигналы мо-

гут редактироваться: выбранные шины —

разгруппировываться, отдельные сигналы —

собираться в шины, для любых сигналов мо-

гут задаваться мнемонические таблицы со-

ответствия (например, состояния управляю-

щей шины могут отображаться в виде наиме-

нований выполняемых операций, значения

семисегментного кода — в виде отображае-

мых цифр и т. п.).

В колонке Data Enable отмечаются сигна-

лы, которые будут захватываться в конкрет-

ном эксперименте — это полезно для умень-

шения объема требуемой для записи отсче-

тов памяти.

В колонке Trigger Enable отмечаются сиг-

налы, которые будут участвовать в логике

формирования сигнала захвата (Trigger).

Как уже говорилось, количество условий

для формирования сигнала захвата (Trigger

Level) задается в области редактирования па-

раметров. Простейший способ формирова-

ния сигнала захвата (Trigger) в последователь-

ностном режиме — использование базовых

условий (Basic), варианты которых предла-

гаются при щелчке правой кнопкой в колон-

ке Trigger Level соответствующей строки.

Каждый Trigger Level выполняется только тог-

да, когда одновременно выполняются усло-

Рис. 19. Представление памяти логического анализатора в виде кольцевого или сегментированного буфера

Рис. 20. Выбор записываемых в буфер SignalTap II сигналов

Рис. 21. Просмотр временных диаграмм STP
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вия, заданные для всех сигналов, участвую-

щих в его формировании.

Для формирования более сложных усло-

вий захвата в последовательностном режиме

(например, с использованием логических опе-

раторов, операторов отношения и операто-

ров задержки) можно использовать услож-

ненные условия (Advanced).

В режиме формирования условий захва-

та на основе машины состояний разработ-

чик может формировать сложные условия

захвата — например, n-кратное повторение

цепочки некоторых событий. В этом режи-

ме процесс формирования захвата описы-

вается в виде машины состояний, для кото-

рой разработчик задает условия перехода из

состояния в состояние и действия, произво-

димые в каждом состоянии. Для описания

машины состояний используется простой

BASIC-подобный язык (рис. 22).

Сигнал захвата Trigger формируется в слу-

чае выполнения любого из активных усло-

вий Trigger Level. После осуществления за-

хвата (в соответствии с установленной пози-

цией захвата — Pre, Center или Post) запись

данных в буфер SignalTap II прекращается

и содержимое буфера становится доступным

для анализа.

Для просмотра временных диаграмм после

захвата данных нужно перейти на закладку

Data (рис. 21). Формат отображаемых данных

может быть задан во всплывающем меню,

вызываемом щелчком правой кнопки на вы-

бранном сигнале.

Область иерархии (Hierarchy Display)

(рис. 23) отображает иерархию сигналов, вы-

бранных для просмотра временных диа-

грамм, и позволяет скрывать любые из них

для удобства анализа остальных.

Область сохранения данных (Data Log)

(рис. 23) позволяет записывать тестовые по-

следовательности для дальнейшего их про-

смотра средствами SignalTap II или преоб-

разования в другие форматы (выбор запи-

санного теста в пункте меню Data Log =>

File => Export => Сохранение в выбранном

формате). Преобразованные тестовые дан-

ные могут наблюдаться и анализироваться

другими средствами, например, средствами

редактора временных диаграмм САПР

Quartus II.

Область настройки JTAG (JTAG Chain

Configuration), как и для рассмотренных вы-

ше средств системной отладки, задает интер-

фейс компьютера и отлаживаемого устрой-

ства (рис. 24).

В этой области, не обращаясь к окну про-

грамматора Quartus II, можно производить

следующие действия:
•• задавать средства программирования

(в примере на рис. 24 выбран загрузоч-

ный/отладочный кабель USB Blaster);
•• определять состояние JTAG-цепочки и вы-

бирать нужную для тестирования микро-

схему;
•• выбирать программирующий файл и за-

пускать процесс конфигурации СБИС ПЛ.

После окончания отладки логический ана-

лизатор SignalTap II может быть исключен

из проекта (пункт меню Assignments =>

Settings => SignalTap II Logic Analyzer). После

удаления SignalTap II из проекта следует со-

хранить существующую разводку проекта

(пункт меню Assignments => Back-Annotate

Assignments => Pin, sell, routing and device

assignments) и перекомпилировать проект.

Установки всех средств системной отлад-

ки, используемых в проекте, отображают-

ся в окне отчета Compilation Report =>

Analysis & Synthesis => Debug Settings

Summary (рис. 25).

Средства системной отладки САПР Quar-

tus II удобны в использовании, и позволяют

существенно упростить процесс верифика-

ции проектов на основе СБИС ПЛ в реаль-

ном аппаратном окружении. Любое из них

может быть добавлено к проекту для осуще-

ствления физического моделирования и ис-

ключено из проекта после его завершения,

при переходе от прототипа к серийной про-

дукции. ■

Рис. 22. Формирование условий захвата с использованием машины состояний

Рис. 23. Области иерархии и сохранения данных STP

Рис. 24. Окно настройки JTAG

Рис. 25. Отображение установок In�System Memory Content Editor в окне отчета


